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ABSTRACT 

Author: Emeka Chigozie Ibekwe 

Title: Neural Network Fatigue Life Prediction in 7075-T6 Aluminum from 

Acoustic Emission Data 

Institution: Embry-Riddle Aeronautical University 

Degree: Master of Science in Aerospace Engineering 

Year: 2004 

The objective of this research was to classify acoustic emission (AE) -data 

associated with fatigue cracks in aluminum fatigue specimens and to use early cycle life 

AE data to predict failure in such members. An AE data acquisition system coupled with 

a Kohonen self organizing map and a back propagation neural network were used to 

perform the analysis. AE waveforms were recorded during fatigue cycling of twenty-

four notched 7075-T6 aluminum specimens using broad-band piezoelectric transducers. 

A Kohonen self organizing map was used to classify the AE flaw growth signals. The 

signals were classified into three categories based on their AE parameters: plastic 

deformation, plane strain fracture and mixed mode (plane strain and plane stress) 

fracture. 

Acoustic emission amplitude data from the twenty-four low cycle fatigue tests 

were used to train and test a back propagation neural network for prediction of cycles to 

failure. The input data consisted of amplitude frequency histograms (30-100 dB) and the 

actual cycle lives. The output was the predicted cycles to failure or fatigue life. A 

network capable of predicting cycles to failure with a worst case error of- 9.30% was the 

final result. 
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1.0 INTRODUCTION 

1.1 Problem Statement 

The scope of the project was to identify fatigue crack growth and predict failure in 

7075-T6 aluminum by classifying acoustic emission (AE) failure mechanism data. The 

data were categorized using a Kohonen self organizing map (SOM) neural network, and 

prediction was made possible using a back propagation neural network (BPNN). The 

aluminum test specimens were notched to promote low cycle fatigue crack growth. They 

were axially cycled between 0 and 4,000 lb, resulting in 50 ksi mean cyclic stresses and 

a stress ratio R = 0.0. 

1.2 Previous Research 

The suitability of acoustic emission for monitoring fatigue crack growth has been 

established in the past. Acoustic emission in conjunction with neural networks has 

proven to be an effective approach for detecting and analyzing fatigue crack growth. 

Almeida and Hill [1,2] used acoustic emission and a SOM neural network to classify 

signals from a riveted double lap joint during an axial cyclic loading. The riveted joint 

was constructed using 7075-T6 aluminum. They were then able to properly classify a 

minimum of 94 percent of crack growth signals and 99 percent of the rivet rubbing 

signals using a BPNN on power spectral density data. 

Thornton and Hill [3] and Marsden and Hill [4,5] used acoustic emission and 

neural networks to monitor crack growth in a simulated aircraft fuselage. They employed 

a pressure vessel constructed from 2024-T3 aluminum. This simulated fuselage 

contained a notched round hole which was patched and cyclically pressurized to stress 

the notch. Marsden and Hill correctly classified time domain AE quantification 
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parameters (rise time, counts, energy, duration, and amplitude) from this test into 

cracking, metal rubbing and rivet fretting using a SOM neural network. Thornton and 

Hill used a SOM and frequency domain (power spectral density) data, to accomplish the 

same objective. 

Subsequently, Vaughn and Hill [6] used acoustic emission to monitor in-flight 

fatigue crack growth. Employing a SOM neural network they were able to distinguish 

crack growth, plastic deformation and rubbing signals in a Piper PA-28 aircraft engine 

cowling during flight. Rovik and Hill [7] monitored the growth of a fatigue crack in the 

vertical tail of a Cessna T-303 while performing various in-flight maneuvers. This was 

accomplished using a SOM neural network on AE quantification parameter data. Both 

projects are summarized in reference [8]. 

Finally, Ballard and Hill [9,10] predicted fatigue lives in inconel and stainless 

steel bellows from early cycle AE data. Back propagation neural networks were used 

initially. Later multivariate statistical analysis was employed as well [11]. The present 

research effort is an extension of this earlier work in fatigue life prediction. 

2 



2.0 BACKGROUND THEORY 

2.1 Acoustic Emission 

Acoustic emission (AE) is a nondestructive testing (NDT) method wherein data 

from stress waves generated by the sudden release of energy during flaw growth are 

collected and analyzed. One advantage of AE testing is that it is a noninvasive form of 

NDT and that it does not require removal of the structure or specimen from service for 

testing. A test article may be analyzed while it is in service under its normal opening 

conditions. Because AE is a passive testing procedure, the specimen requires some type 

of loading to generate the stress waves. Other forms of NDT, such as radiographic or dye 

penetrant testing, require an active method of probing the specimen and analyzing the 

response. One drawback to AE testing is that it is typically necessary to destroy at least 

one sample to acquire a reference set of AE data in order to properly adjust the test setup 

and ensure optimum data collection. 

2.1.1 Waveform Parameters 

Five AE waveform quantification parameters were utilized or collected during the 

cyclic testing (Figure 2.1). The three parameters used herein were amplitude, counts, and 

duration. Amplitude, measured in decibels [dB], is the maximum height of the 

waveform. Counts are the number of recorded peaks above the threshold, which is an 

artificial filter value below which no data is recorded. Duration, measured in 

microseconds [p,s], is the time the waveform signal lasts. 
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, Rise 
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Ami 
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r^L_5_F7i_nLJ7L_r7LJ^_g a™* 

Figure 2.1 Waveform signal 

The other two AE parameters are rise time (microseconds [jxs]), which is the time 

it takes to reach the peak amplitude, and energy which is a function of both amplitude 

and duration. Energy is measured as the area under the rectified signal waveform. 

2.1.2 Wave Speed Calculations 

Given below are the calculated Lame constants, X and u, which are used to 

determine the longitudinal wave speed (ci), transverse wave speed (C2), plate wave speed 

(Cp), Raleigh wave speed (Cr) and group wave speed (Cg) for the aluminum specimens. 

A = -
Ev _10.4*106(0.32) 

(\ + v)(\-2v)~ 1.32(0.36) 
= 7.00* 10 6psi 

M 
10.4*106 

2(1 + u) 2(1.32) 
= 3.94*10" psi 
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A+ 2/i 7.00*106 + 2(3.94*106) 1 0 „ . . , 
c. = I c - = i / =12,353 1/1/5 

1 V P V 0.0975 

// 3.94*106
 £ ^ n . , 

c2= /—=J =6,357 inls 
2 Vp V 0.0975 

^ = c 2 J — ^ — = 6 , 3 5 7 J — = 10,902 inls p 2V(l-u) V0.68 

0.87 + 1.12u ^ c 10.87 + 1.12(0.32) ^ „ . , cr=c2\ = 6,357J -=6,132 inls 
V 1 + u V 1.32 

cg= 0.91^=0.91(10,902) = 9,232 zWs 

The group velocity cg was used in conjunction with the data acquisition software 

to generate a location plot of AE activity. Plots of events versus position can be seen in 

Appendix A. Note that events could not have been accurately plotted at the notch 

location if the wave speed calculations were not correct. 

2.2 Neural Networks 

An artificial neural network (ANN) is a massively parallel system used for data 

processing comprised of artificial neurons or processing elements that allow a series 

processor (digital computer) to function as a parallel processing system which more 

closely resembles the human brain in efficiency and capability. This increase in 

efficiency allows the network to analyze very complex and noisy data more effectively 

than by other means such as statistical curve fitting. Two types of ANNs are used here, a 

self organizing map (SOM) used for classifying data into categories and a back 

propagation neural network (BPNN) used for predicting cyclic lives based on early cycle 
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AE failure mechanism data. Details of the operation of these two networks are provided 

in a tutorial by Walker and Hill [12]. 

2.2.1 SOM Network Architecture 

A Kohonen self organizing map (SOM) neural network is a neural network that is 

capable of classifying a set of input data into different categories. The SOM architecture 

shown in figure 2.2 consists of three layers: 

• Input layer - the number of nodes for the input layer depends oh the 

number of inputs that are going to be used in the network each time. 

• Kohonen layer - the number of nodes for the classification layer depends 

on the number of different categories that are desired. 

• Output layer - step activation functions produce 0 or 1 output to identify 

the classification category. 

Five input neurons were used to input the AE waveform parameters (amplitude, 

counts, duration, energy and rise time) for each hit. Three Kohonen neurons were then 

used to classify the AE hits into three categories: localized plastic deformation (0 0 1), 

plane strain fracture (0 1 0), and mixed mode fracture (1 0 0). 

Classification 

AE Parameters 

Input Kohonen Output 
Layw Layer Layer 

Figure 2.2 SOM network architecture 
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2.2.2 Back Propagation Network Architecture 

Figure 2.3 shows a schematic of the back propagation network architecture. The 

network consisted of three layers: an input layer, a hidden layer, and an output layer. 

Seventy-one input neurons were used to input the amplitude frequency histogram from 

each specimen. The middle or hidden layer was the processing layer, mapping the input 

into the output. The single output neuron was used to predict cycles to failure. 

Bias 

Amplitude 
Histogram 

Output Layer 

Input Uyer Hidden Layer 

Figure 2.3 Back propagation network architecture 
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3.0 EXPERIMENTAL SETUP 

3.1 Test Specimens 

Twenty-four 7075-T6 aluminum test specimens per AMS 4045 were used for the 

cyclic testing. Figure 3.1 is a sketch of the samples. A 0.200 inch deep, 45 degree angle 

notch was added to the samples to initiate crack growth. 

\45v L 
v/ — 

0.10" Thick 

0.80" 1.00' 

15.00" 

Figure 3.1 Test specimen 

3.2 Fatigue Life Calculation 

The test specimens were loaded axially to induce mean cyclic stresses of 50 ksi in 

the material. Shown below are the calculations used to arrive at the desired mean cyclic 

stress. 

Areacross-^tion = 0 . 0 8 W* 

J U = 4,000 » 

Pcyclic 4,000 . 
cr .. = —— = = 50,000 psi 

cyc"c A 0.08 
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To make sure that the load would be sufficient to break the part in a reasonable 

length of time, a fatigue life chart was consulted. Looking at the fatigue life chart below 

(Figure 3.2) [13], it can be seen that for a 50 ksi cyclic axial load and a stress ratio R= 0.0 

the specimen will experience fatigue at approximately 1600 cycles. 

MIL-IIDUK-511 
1 December 1998 

"RTIGJE L I F E . CYCLES 

Figure 3.7.4.1.8(c). Beat-fir $/N evrve* for notched ^ - ?.4, 7075-T* alvranvm 
alloy rolled b«y lengkvdmal direction. 

Figure 3.2 Fatigue life chart 

9 



3.3 Test Equipment Overview 

The test equipment consisted of an MTS Machine to provide the desired cyclic 

loading of the specimens, an MTS Controller and Display units to provide adequate 

control of the MTS Machine, and a Data Acquisition System (DAS) or computer to 

record the AE data as they were generated. Figure 3.3 shows a schematic diagram of the 

data flow within the test system. 

Data Acquisition System 
(DAS) MTS Machine 

Figure 3.3 Equipment schematic 
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3.4 MTS Machine and Controller Setup 

The process to set up the MTS Machine and Controller was as follows: 

1. Disable the interlock. 

2. Adjust the level of the lower grip to allow for cycling. 

3. Set the Controller to DC to configure the units to pounds (lb). 

4. Set the workload of the Controller for the desired cycling load(s) (Setpoint = 2,000 

and Span = 2,000 for 0 to 4,000 lb cyclic loading). 

5. Connect the transducers and Controller to the DAS. 

3.5 Preparation of Specimens 

The test specimens were prepared by attaching the AE transducers asymmetrically 

on both sides of the notch to facilitate location of the fatigue cracks (Figure 3.4). The 

specimens were then clamped vertically in the MTS Machine to ensure loading in the 

long transverse direction. The lower and upper transducers were then connected to the 

DAS as Channels 1 and 2 respectively. 

11 



Figure 3.4 Test specimen setup 

3.6 Preparation of DAS Software (MISTRAS) 

The preparation of the DAS software is outlined as follows: 

1. Generate the configuration file. 

2. Set: threshold = 30 dB; PDT = 300 ^sec; HDT = 600 ^isec; HLT = 150^sec. 

3. Define the available channels: 1 & 2. 

4. Set the distance between the transducers: 7 in. 

5. Set the desired output graphs. 

6. Set the monitoring and data recording process to standby. 

7. Start the monitoring and data recording at the beginning of cycling. 

12 



4.0 RESULTS 

The data were collected in real time using the MISTRAS data acquisition 

software. They consisted of the previously designated AE parameters for each signal 

waveform (hit). Real time data acquisition was displayed using the line dump feature in 

MISTRAS. Once collected, the data were saved to an electronic file using the autodump 

function. Saved data were then converted to ASCII format for the analysis described in 

section 5.0. Figure 4.1 shows a sample ASCII file for thirty-nine AE hits. 

'(FILE: C:\MISTRAS\IMPACT\SAMPLE~1 .DTA)" 

"(TEST START DATE A TIME)" 
"(Mon Mar 10 14:53:08 2003)" 

"(COMMENTS)" 
"(MISTRAS-2001 DATA ACQUISITION TEST)" 

"(ACTIVE AE DATA SET PARAMETERS)" 
"(DDD""HH""MM""SS.mmmuuun)" "(PARAl)" 
0 0 00:00:02.8678513 -10.10 
0 00:00:02.8679213 -10.10 
0 00:00:14.5541655 -10.09 
0 00:00:43.1972753 -10.09 
0 00:01:32.3917240 -10.10 
0 00:02:01.0341610 -10.09 
0 00:02:09.2514013 -10.10 
0 00:02:54.2882037 -10.10 
0 00:03:31.1887135 -10.10 
0 00:03:43.4329365 -10.09 
0 00:04:53.1147675 -10.10 
0 00:04:53.1148527 -10.10 
0 00:05:29.9843787 -10.10 
0 00:05:34.0616217 -10.09 
0 00:05:34.0616627 -10.09 
0 00:05:57.8889270 -10.09 
0 00:06:40.5880227 -10.09 
0 00:06:40.9235285 -10.09 
0 00:06:40.9285773 -10.10 
0 00:06:40.9596495 -10.09 
0 00:06:41.6582663 -10.09 
0 00:06:41.6839127 -10.10 
0 00:06:41.6865065 -10.10 
0 00:06:41.8729167 -10.10 
0 00:06:41.8808855 -10.09 
0 00:06:41.8849440 -10.10 
0 00:06:41.9321060 -10.09 
0 00:06:41.95064 55 -10.09 
0 00:06:41.9543200 -10.10 
0 00:06:41.9747137 -10.09 
0 00:06:41.9770655 -10.10 
0 00:06:41.9910625 -10.10 
0 00:06:41.9947813 -10.10 
0 00:06:41.9987417 -10.10 
0 00:06:42.0008597 -10.10 
0 00:06:42.0179035 -10.09 
0 00:06:42.0220150 -10.10 
0 00:06:42.0254485 -10.09 
0 00:06:47.0774860 -10.10 

"(CH)" 
1 
2 
2 
1 
1 
1 
1 
1 
1 
1 
1 
2 
1 
1 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 
2 

"(RISE)" 
1 
1 

116 
1 
1 
1 
3 
1 
1 
1 
10 
1 
1 
1 
1 
53 
40 
1 
1 
15 
11 
8 
88 
2 
1 
1 
37 
98 
1 
3 

342 
86 

175 
71 
23 
45 
5 
1 
1 

"(COUNTS)" 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 

882 
4 
1 
1 
12 
2 
3 

15 
2 
1 
7 

11 
14 
1 
1 
7 
8 
5 

11 
2 
25 
5 
1 
1 

'(ENERGY)" 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
38 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
1 
0 
0 
o 

'(DURATION)" 
5 

1 
117 
1 
1 
1 
4 
1 
1 
1 
46 
1 
1 
1 
1 

13859 
88 
1 
4 

186 
27 
70 
314 
120 
1 

102 
156 
224 
1 
4 

413 
647 
282 
378 
221 
460 
316 
1 
1 

"(AMP)" 
37 
30 
31 
30 
34 
32 
30 
30 
32 
30 
31 
31 
33 
31 
30 
42 
33 
31 
32 
35 
31 
34 
37 
33 
30 
36 
36 
35 
31 
31 
34 
36 
33 
33 
33 
41 
34 
33 

^ 

Figure 4.1 Sample ASCII file 
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Figure 4.2 shows screen plots of the AE parameters. Refer to Appendix A for 

plots of duration vs. amplitude and events vs. position for the first thirteen samples. 

Figure 4.2 AE parameter plots 

Note that the hits vs. cycles plot had no output because the plot setup was incorrect for 

this particular test. This was corrected for later tests. 

14 



Effect of Automation Management Strategies 20 

the flashing conditions, or white in the auditory conditions when instead an auditory alert 

sounded simultaneously with the appearance of the dialog box. One alert (whether visual 

or auditory) was present for each condition except in baseline control conditions. The 

alert did not cease until the participant selected an option in management by consent 

(MBC) conditions or ran out of time in the management by exception (MBE) conditions 

(after six seconds had passed). Figure 3 provides an example of an image used in the 

experiment and a sample dialog box for when the automation stated that a threat existed 

while Figure 4 provides an example of when automation stated no threat existed. Please 

note that both Figure 3 and Figure 4 are examples of management by consent (MBC) 

because an option to accept or reject automation's response is provided. 

% 

0 

5 

•:. 

EBB 
Alert! Threat Found! 

Search baggage. 

ACCEPT REJECT 

Figure 3. Example of Management by Consent (MBC) Image with Threat Text 



A duration vs. counts plot of the same data demonstrates the overall quality of the 

data. Correlation of this data is quite high at 96.52 percent, meaning that there were very 

few noisy hits. 

Duration (\is) vs Counts (All Data) 

16000 
14000 

~ 12000 
£ 10000 
I 8000 
| 6000 
Q 4000 

2000 
0 

0 500 1000 1500 

Counts 

Figure 5.2 Duration vs. counts 

5.1.1 SOM NeuralWorks Professional II/Plus Setup 

The analysis in this section incorporates the concepts introduced earlier in section 

2.2.1. The SOM NeuralWorks Professional II/Plus software has the capability to classify 

data if configured properly. Detailed instructions on configuring the SOM NeuralWorks 

Professional II/Plus software are located in the Appendix B. Also reference "Training 

and Testing A Self-Organizing Map Neural Network using NeuralWorks Professional 

II/PLUS" [Bibliography] for more details. Figure 5.3 shows the network settings for the 

analysis. 

16 



Figure 5.3 ANN parameters 

5.1.2 Training File Results 

Table 5.1 summarizes the classification results from the training file. It should be 

noted here that the plastic deformation is localized at the crack tip. 

Table 5.1 Training file results 

Rise Time 
6 
15 
18 
18 
19 
20 
18 
17 
17 
16 
35 

1214 
32 

i 45 
88 
42 
124 
691 
17 
12 
19 
18 
44 
48 
20 

272 
276 
4 
37 
172 
24 
391 
13 

Counts 
23 
23 
17 
17 
16 
15 
14 
13 
13 
12 
11 

843 
775 
390 
375 
167 
150 
146 
110 
95 
55 
50 

5926 
1094 
643 
533 
426 
320 
211 
195 
161 
149 
131 

Energy 
0 
1 
0 
0 
0 
0 
0 
0 
0 
0 
0 

16796 
1479 
388 
771 J 
112 
48 
19 
31 
18 
4 
4 

4190 
201 
27 
29 
28 
36 
8 
9 
7 
17 
5 

Duration 
200 
197 
182 
172 
180 
157 
170 
144 
144 
156 
208 

9606 
10096 
5827 
4499 
1783 
1785 
1549 
1422 
1256 
567 
519 

48932 
12670 
7045 
5892 
3295 
6267 
1109 
1716 
1073 
2989 
1006 

Amplitude | Category | Failure Mechanism | 
43 
45 | H- 0 1 

o 1 
45 I | 0 0 | ! 
46 
42 
45 
45 
45 
45 
43 
39 
98 
94 
91 
91 
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76 
66 
71 
68 
58 
58 
96 
77 
48 
56 
57 
62 
49 
48 
53 
60 
46 

I 0 0 1 j 
0 0 

o o l 0 0 1 
0 0 
0 0 
0 0 
0 0 
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0 0 1 Plane Strain Fracture 
0 0 | Plane Strain Fracture 
0 0 
0 0 
0 0 
0 0 
0 0 
0 0 
0 0 
0 0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 

0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 

Plane Strain Fracture 
Plane Strain Fracture 
Plane Strain Fracture 

i Plane Strain Fracture 
Plane Strain Fracture 
Plane Strain Fracture 
Plane Strain Fracture 
Plane Strain Fracture 

Mixed Mode Fracture 
Mixed Mode Fracture 
Mixed Mode Fracture 
Mixed Mode Fracture 
Mixed Mode Fracture 
Mixed Mode Fracture 
Mixed Mode Fracture 
Mixed Mode Fracture 1 
Mixed Mode Fracture i 
Mixed Mode Fracture | 
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5.1.3 SOM Network Test Results 

Figure 5.4 shows the classification results from the test file containing data from 

all twenty-four specimens. As expected [15], the SOM classified the data into three 

categories: localized plastic deformation at the crack tip, plane strain fracture, and mixed 

fracture mode consisting of both plane strain and plane stress components. 

100000 

_ 10000 
0) 

c 
o 
(0 
3 
Q 

Duration (us) vs Amplitude (dB) 

• Mixed Mode Fracture 
• Plane Strain Fracture 

Plastic Deformation 

30 40 50 60 70 80 90 100 

Amplitude (dB) 

Figure 5.4 Test file results, duration vs. amplitude 

Figure 5.5 through 5.7 show the amplitude distribution histograms with the three 

failure mechanisms broken down into categories and then combined. 
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Amplitude Distribution By Category 
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Figure 5.5 Amplitude distribution by category 
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Figure 5.6 Amplitude distribution by category 
(Localized plastic deformation removed for clarity) 
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Figure 5.7 Combined amplitude distribution 
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The approximate waveform parameter ranges are summarized in Table 5.2: 

Table 5.2 AE waveform parameter ranges 

Failure Mechanism 
Plastic Deformation 

Plane Strain Fracture 
Mixed Mode Fracture 

Energy 
(counts) 

0 - 5 
0 82 

0-21,846 

Duration 
(us) 

1 -461 
76 - 1,973 

91 115,201 

Amplitude 
(dB) 

30-55 
53-81 
30-99 

Furthermore, Figures 5.8 and 5.9 exhibit a high level of data quality due to their 

high coefficient of determination (R > 0.90) values. This indicates that the data for 

localized plastic deformation at the crack tip and plane strain fracture signals contain 

little noise. Mixed mode fracture (Figure 5.10), on the other hand, appears to contain a 

lot of noise as indicated by the scatter around the trend line and the R2 value being less 

than 0.90. 
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Duration (us) vs Counts (Plastic Deformation) 

Figure 5.8 Duration vs. counts (plastic deformation) 

Duration (us) vs Counts (Plane Strain Fracture) 
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Figure 5.9 Duration vs. counts (plane strain fracture) 
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Figure 5.10 Duration vs. counts (mixed mode fracture) 
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The reason the mixed mode fracture data set has a lower R2 value than the other 

two mechanisms is that this data set contains multiple hit data. Multiple hit data comes 

from setting the hit definition time (HDT) on MISTRAS too long. The waveform below 

(Figure 5.11) has a HDT that is set properly. Notice that the HDT is the right length to 

define the first wave-form before the onset of the next waveform. If the HDT is set too 

long the second waveform will be considered a part of the first, i.e., two hits will be 

combined. As such, the multiple hit data will appear on the duration vs. counts plots in 

the upper left hand portion of the graph above the trend line. This occurs because the 

software records longer durations (D) than normal for a given number of counts (C), 

ruining the natural linear relationship between the two (D = kC). 

Threshold 

n_rLn_rLTL_n_rL_rL JL_rLn_rL_n_n_rLJi Counts 
1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 

Figure 5.11 HDT/HLT schematic 

When looking at the statistics related to each mechanism, the poor quality of the 

data for mixed mode fracture can also be seen. From the kurtosis [14] of the mixed mode 

fracture, which would be between 2 and -2 for normally distributed data, it can be seen 
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that the counts and duration are far in excess of these values. Note also that the kurtosis 

values are higher in general for the mixed mode fracture statistics than either the plastic 

deformation or plane strain fracture modes. 

Table 5.3 Statistics for fracture modes 

Plastic Deformation n = 18,158 

Counts 
Amplitude 
Duration 
Energy 
Rise Time 

Mean 
5.01 

35.40 

53.99 

0.07 

12.07 

Standard Deviation 
6.76 

5.17 

73.37 

0.32 

17.85 

Skewness 

2.58 

1.24 
2.25 

4.99 

3.11 

Kurtosis 

7.49 

1.03 

5.50 

29.50 

16.57 

Plane Strain Fracture n = 834 

Counts 
Amplitude 
Duration 
Energy 
Rise Time 

Mean 
58.91 

59.46 

637.31 

7.67 

54.34 

Standard Deviation 
31.18 

5.16 

368.61 

8.36 

85.39 

Skewness 

1.30 

1.02 

1.28 

3.46 

1.30 

Kurtosis 

1.66 

0.81 

1.34 

17.80 

24.72 
Mixed Mode Fracture n = 3,631 

Counts 
Amplitude 
Duration 
Energy 
Rise Time 

Mean 
115.02 

42.68 

1852.08 

121.21 

156.89 

Standard Deviation 
507.81 

13.33 

6445.35 

979.11 

247.50 

Skewness 

9.39 

2.13 
8.76 
11.31 

3.91 

Kurtosis 

105.33 

4.96 

96.09 

153.84 

28.19 

5.2 Back Propagation Network Test Results 

Using a back propagation neural network it was possible to predict the cycles to 

failure with a worst case error of -9.3 percent. This network was trained on AE 

amplitude data up to fifty percent of the total cycles to failure. The training data are 

shown in Table 5.4 followed by the testing data in Table 5.5. 
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Table 5.4 Training data 

Specimen # 
1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

Cycles To Failure 
822.50 

1,063.50 

582.00 

588.25 

495.00 

553.00 

456.50 

765.50 

499.25 

841.50 

472.75 

559.75 

545.75 

765.50 

719.25 

516.50 

376.25 

454.00 

310.75 

422.25 

Amplitude Distribution Data (30 -100 dB) 
939 913 537 878 651 373 284 242 185 173 138 78 92 85 28 14 4 5 4 3 0 0 0 1 0 0 
1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

1861 1019 630 1155 840 289 155 172 164 130 88 33 25 10 10 7 5 3 2 2 2 2 0 0 1 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
1689 1035 545 1072 902 393 230 245 191 140 159 92 72 43 39 88 193 60 17 13 7 4 4 0 
0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

2004 1104 564 1052 902 346 154 129 104 115 86 47 37 27 36 23 16 7 7 10 8 4 3 0 1 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
429 52 11 12 6 3 2 0 1 3 0 1 0 0 1 1 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
335 141 87 125 78 33 24 10 9 3 1 1 0 1 0 1 0 0 0 1 0 0 1 0 0 0 1 0 0 1 0 0 0 0 0 0 1 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
1318 607 263 470 359 121 93 118 84 28 9 13 6 0 3 3 2 2 2 2 0 0 1 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
1647 630 295 591 635 308 141 79 41 29 23 13 5 4 8 4 1 0 1 1 0 0 0 0 0 0 0 0 ^0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
861 338 161 325 370 167 68 64 13 18 35 27 16 30 29 20 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
758 216 120 271 257 102 48 41 27 51 147 26 0 1 1 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
424 110 4169 46 20 5 4 2 2 5 0 0 1 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
465 89 35 37 12 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
688 387 205 375 286 114 89 143 102 37 10 6 6 4 5 2 6 6 2 3 0 1 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

630 189 64 51 10 1 1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
600 183 86161 122 27 4 1 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

786 372 185 277 285 149 78 96 93 55 7 5 2 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
253 311 132 241 265 161 145 189 156 96 102 19 14 4 1 2 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

103 194 130 247 168 75 55 98 86 46 41 44 26 40 32 8 6 2 1 0 2 1 1 3 2 0 2 1 1 0 1 1 
0 1 0 0 0 1 1 1 0 2 2 0 0 0 0 0 0 1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0 1 0 5 0 0 
129 159 85 140 127 63 55 74 56 61 74 62 40 24 20 10 9 7 8 10 3 4 6 6 2 3 1 4 2 2 3 0 
0 0 1 3 0 0 1 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

43 601742 33 18 20118 18 20 914 107 8 3 93 6 5 4 6 4 4 0 5 4 4 1 0 1 1 1 21 1 1 
1 0 3 2 0 0 2 1 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

Table 5.5 Testing Data 

Specimen # 
21 

22 

23 

24 

Cycles To Failure 
419.5 

492.0 

452.0 

423.0 

Amplitude Distribution Data (30 -100 dB) 
121 167 87 118 8640 342623 1010118 5 8 4 4 2 1 4 1 4 4 1 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
121 207 100 136 42 6 10 6 3 8 10 7 6 5 3 3 4 1 4 3 5 2 5 1 3 2 0 0 0 0 0 0 0 0 0 0 0 0 0 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

91 81 42 67 33 33 24 34 31 20 23 15 10 12 16 7 6 7 9 8 4 8 1 7 5 1 1 3 1 1 1 0 1 1 1 1 
2 0 0 0 0 0 1 0 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

64 46 3048401713 1218 920 13 13 15 75 1 0 4 6 3 3 6 6 1 2 3 2 1 3 13 101 1 1 1 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 2 0 0 
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5.2.1 Back Propagation NeuralWorks Professional II/Plus Setup 

Reference the "Tutorial for Optimizing a Back Propagation Neural Network 

Using NeuralWorks Professional II/Plus" [Bibliography] for detailed instructions on 

configuring the back propagation software. Detailed instructions on configuring the Back 

Propagation NeuralWorks Professional II/Plus software are provided in the Appendix C. 

Figure 5.12 shows the network settings for training the network to obtain the desired 

results. 

HPE» 

Input W L C o e ' Momentum [0 400 

Hidl |28 [0500 Tians.Pt [ToOOO 

Hid 2 |5 |blob" LCoef Ratio [bloT 

H,d3 |0 [0200 FOHset|blob" 

Output |1 |0 151 

r Connect Prior T Gaussian In*. 

f~ Auto-Assoc \~ Mmmal Config 

r Linear Output W MinMax Table 

r SoftMax Output I* Bipolar Inputs 

V Fast Learning f"~ Cascade Learn 

i |new-and-o*d-train.txt 

r Logtton PROJECTION NETWORK |TM) |old-te$t470 txt 

Set Epoch From Fie | | OK Caned | Help | 

Figure 5.12 Back propagation network settings 

25 

http://Tians.Pt


5.2.2 Back Propagation Neural Network Results 

The training set was compared to the predicted values after training. These values 

gave the following output (Table 5.6). Note that the worst case training error is 16.44 

percent. 

Table 5.6 Back propagation network training results 

Specimen 
# 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 

Actual Results 
(cycles) 
822.50 
1063.50 
582.00 
588.25 
495.00 
553.00 
456.50 
765.50 
499.25 
841.50 
472.75 
559.75 
545.75 
765.50 
719.25 
516.50 
376.25 
454.00 
310.75 
422.25 

Predicted Results 
(cycles) 
821.32 
1058.38 
583.88 
586.32 
477.18 
554.65 
463.94 
764.88 
496.98 
837.73 
550.47 
537.58 
544.08 
694.45 
747.68 
507.79 
371.74 
452.85 
310.72 
421.71 

% Error 
-0.14 
-0.48 
0.32 
-0.33 
-3.60 
0.30 
1.63 

-0.08 
-0.45 
-0.45 
16.44 
-3.96 
-0.31 
-9.28 
3.95 
-1.69 
-1.20 
-0.25 
-0.01 
-0.13 

The above settings resulted in a network that when tested gave the following output 

(Table 5.7), where the worst case testing error was -9.30%. 

Table 5.7 Back propagation network predicted results and percent errors 

Specimen # 
21 

22 
23 

24 

Actual Results (cycles) 
419.50 

492.00 

452.00 

423.00 

Predicted Results (cycles) 
380.50 

474.65 

482.21 

399.92 

% Error 
-9.30 
-3.53 

+ 6.68 

-5.46 
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Figure 5.13 Screen shot of BPNN results showing network weights 

Figure 5.13 shows the RMS error, correlation, and the final network weights 

assigned to the amplitude frequency distribution input. A closer look at the normal 

distribution of the weights shows that non-zero weights were assigned to the range of 

amplitudes (53 - 81), which corresponds to plane strain fracture. The amplitudes at 

the tail ends of the distribution had zero weights. This shows that the plane strain 

fracture mechanism is highly correlated with failure of the specimens, and thus is 

essential for prediction of cycles to failure. Figure 5.14 illustrates this correlation. 

1200 

1000 

2 800 
c 

o 400 
it 

200 

0 

Amplitude Distribution By Category 

• Network Weights 

B til ]JTl r-0 • r-jQr-

S> *S> <S> <£> <& o £ o?> ^ «P F *? <<? «F V °r ^N 

Amplitude (dB) 

nP lane Strain Fracture 

• Mixed Mode Fracture 

Figure 5.14 Network weights distribution by failure mechanism category 
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6.0 CONCLUSIONS AND RECOMMENDATIONS 

6.1 SOM neural network 

It was concluded that the SOM network was able to successfully sort acoustic 

emission data into the three expected failure mechanisms [15]: plastic deformation, plane 

strain fracture, and mixed mode (plane strain plus plane stress) fracture. It is 

recommended that additional samples be tested using a revised hit definition time (HDT) 

setting. This may help eliminate the multiple hit data that were collected. Furthermore, 

additional tests should be conducted using different cyclic loads to examine the netjvork 

capability towards predicting fatigue life under different circumstances. Lower cyclic 

loads should be utilized to induce more fatigue crack emissions. 

6.2 Back Propagation Neural Network 

NeuralWorks Professional II/Plus software appears to have successfully created a 

back propagation neural network which has the ability to predict fatigue life to failure in 

these specimens. From the BPNN weights the plane strain fracture mechanism was 

found to correlate most highly with the fatigue life predictions. Thus, prediction might 

also have been accomplished with the plane strain fracture AE data alone if the data had 

not been so sparse. Sparseness of the data could be avoided in the future by reducing the 

cyclic load in order to promote more fatigue crack growth emissions. Prediction errors in 

either the training or testing results greater than 5 percent were not desirable. Minimizing 

the multiple hit data would probably provide the desired ± 5 percent prediction accuracy. 
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Appendix A - Data Plots 

Sample 1 Data 
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Sample 2 Data 

33 



Sample 3 Data 
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Sample 4 Data 
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Sample 5 Data 
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Sample 6 Data 
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Sample 7 Data 
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Sample 8 Data 
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Sample 9 Data 
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Sample 10 Data 
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Sample 11 Data 
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Sample 12 Data 

43 



Sample 13 Data 

44 



Appendix B 

Example of Kohonen Self-Organizing Neural Network by Hand Calculation 

Objective 

Determine new weights for self-organizing network with two inputs (Xi, X2), and five cluster 
elements (Di, D2, D3, D4, D5). Use a learning coefficient (LC) of .25 and a neighborhood 
factor of 1. 

Network Schematic 

Figure Bl - Network Schematic 

Initial Data 

0.3 0.6 0.1 0.4 0.8 
Wu = 13 0.7 0.9 0.5 0.3 0.2 

Xx = [0.5 0.2] 

Process 

First compute Euclidean distances: 

Next, determine the minimum Euclidean distance and update the surrounding weights within 
the neighborhood factor using: 

Wuinew) ~ Wij{oid) + LCx yXt - WlJ{old)j 

For example, if D2 is the minimum Euclidean distance, update Wn, W2i, Wi2, W22, Wi3, & 

w2 3 . 

Repeat process iteratively until the weight column being revised has reach the value of the 
input vector to within a desired error interval. 
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Summary of Results 

Table Bl lists the iterative weight values for the given initial data set. Iterations were stopped 
upon reaching the input to within .001 (19 iterations). Iteration 20 is shown for reference. 

Iteration: 
Wij: 

Iteration: 
Wij: 

Iteration: 
Wij: 

Iteration: 
Wij: 

Iteration: 
Wij: 

0 
0.3 
0.7 
1 

0.3 
0.7 
2 

0.3 
0.7 
3 

0.3 
0.7 
4 

0.3 
0.7 

0.6 
0.9 

0.6 
0.9 

0.6 
0.9 

0.6 
0.9 

0.6 
0.9 

0.1 
0.5 

0.180 
0.440 

0.244 
0.392 

0.295 
0.354 

0.336 
0.323 

0.4 
0.3 

0.420 
0.280 

0.436 
0.264 

0.449 
0.251 

0.459 
0.241 

0.8 
0.2 

0.740 
0.200 

0.692 
0.200 

0.654 
0.200 

0.623 
0.200 

Iteration: 
Wij: 

Iteration: 
Wij: 

Iteration: 
Wij: 

Iteration: 
Wij: 

Iteration: 
Wij: 

5 
0.3 
0.7 
10 
0.3 
0.7 
15 
0.3 
0.7 
19 
0.3 
0.7 
20 
0.3 
0.7 

0.6 
0.9 

0.6 
0.9 

0.6 
0.9 

0.6 
0.9 

0.6 
0.9 

0.369 
0.298 

0.457 
0.232 

0.486 
0.211 

0.494 
0.204 

0.495 
0.203 

0.467 
0.233 

0.489 
0.211 

0.496 
0.204 

0.499 
0.201 

0.499 
0.201 

0.598 
0.200 

0.532 
0.200 

0.511 
0.200 

• 
0.504 
0.200 

0.503 
0.200 

Table Bl - Summary of Iterative Solutions 

Introduction to Kohonen Self-Organizing Neural Network Software 

A Self Organizing Map (SOM) Neural Network is a neural network that is capable of 
categorizing a set of input data into different categories. A SOM architecture consists of two 
layers: 

• Input Layer - the number of nodes for the input layer depends on the number 
of inputs that are going to be used in the network each time. 

• Output Layer - the number of nodes for the output layer depends on the 
number of different categories that is desired. 
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Figure Bl.l -Network Schematic 

As in Figure Bl.l, the SOM has 4 nodes in the input layer and 2 nodes in the output layer. 
All of the nodes are connected to each other, and each connection is assigned a weight. 
Initially these weights are assigned random values, and during the learning process the 
weights are updated. After the network is trained, the network will be able to map a given set 
of inputs to one of the categories. 

In this tutorial, two examples are used to demonstrate how to train and test a SOM. 

Objective 

The objective of this tutorial is to: 
• Demonstrate the capability of the SOM. 
• Familiarize the reader with the software of NeuralWorks Professional II/PLUS 

through the training and testing of a SOM. 
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Data Preparation 

This section discusses how to prepare the data that will be used by the software. If the user is 
familiar with the process of preparing the data, this section can be skipped and the user may 
move on to the next section. 

The following are step by step instructions on how to prepare the data: 

1. Start Microsoft Excel. 
2. Enter the following data into 2 separate columns: 

1 
5 
9 

1 
5 
9 

3. Then select >File>Save As. 
will appear: 

under the File pull down menu. The following window 

Set the Save as type: 
to be Tex t(Tab 
delimited), and 
Filename to be train 
or some other file 
name. 

r 
History 

My Documents 

£ My Documents 

I ]AE590 

Z]Guidant 

J j ICQ Lite 

2 ] mr_hassan_abbas 

Jjmse655 

2} My Pictures 

2J My Received Files 

2 l Picture 

|]Book2 

JLJxJ 

T3 <- - s o L ni' Tools « 

My Network 
Places Save as type: |Text (Tab delimited) 

"31 [ 
3 

Figure B2.1 - Sample Screen plot 

4. After saving the file, the training data that is going to be used to train the network is 
prepared. If a different set of data is to be used for testing, repeat steps 2 and 3 with 
the testing data using a different filename. 

Note: In this tutorial, both the training and test data are going to be the same, so no other 
test data needs to be prepared in this case. 

48 



Program Usage and Data Analysis 

In this section, two examples are used. The first example is simple and is used to inform the 
user as to how to construct and train a SOM. The second example is more practical and 
shows how the SOM may be applied in real life situations. 

SOM Network Construction 

A set of training data has already been saved in a file named train.txt. The following is a step 
by step process on how to create a SOM: 

1. Start the NeuralWare Professional II/Plus (NWP2+) software. 
2. Select >InstaNeOSelf Organizing Map... as shown in the Figure B3.1. 

Figure B3.1 - Sample Screen Plot 

3. A new window will appear as in Figure B3.2. Enter the data as shown and then click 
on the OK button. 
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InstafSet / Self Organizing Map 

Inputs 

ttRows 

HCols 

Hidden 

Output 

2 

1 
3 

0 

o 

LCoe( 

0.060 

0.250 

|0.150 

HSOM steps 

Beta 

Gamma 

LCoef Ratio 

Trans. Pt. 

2000 

0.333 

1.000 

0.500 

10000 

Mapping Layers 

Learn Rule Transfer i 
ExtDBD 
QuickProp 
MaxProp 
Delta-Bar-Delta 

Sigmoid 
DNNA 
Sine 

I " Coord. Layer 

P Output Network 

W MinMax Table 

f " Interpolate 

Neighborhood: 

f* Diamond 

<• Square 

<~ Alternating 

F Start Width 

End Width 

Wrap Around: 

P Horiz. r Vert. 

Connect Prior 

Connect Bias 

P Linear Output 

r SoftMax Output 

I/O Files 

Learn Browse... A ^ ^ f 

| train.txt 

Recall / Test Browse. 

|train.txt 

Epoch Set Epoch From File | OK Cancel | Help 

These 
buttons allow 

user to locate the 
two files that 
were created 

earlier* 

Figure B3.2 - Sample Screen Plot 

The reason for setting *# Rows' equal to 1 and '# Cols' equal to 3 is to train the 
network to map the input into a 1 x 3 matrix output layer. The value of "Output" is 
set to 0, because this parameter is only useful when the SOM is linked to other neural 
network. 

After the network is created, a new window will appear as shown in Figure B3.3 and 
will provide the user with the choice of data that will be displayed during the training 
process. In this case, all the options are selected. Click OK. 

«Instrument / Create 

Cancel Help 

Figure B3.3 - Sample Screen Plot 
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SOM network training and testing 

The steps for training a network areas follows: 
1. Select >Run>Learn from the Run pull down menu. A new window will appear as 

shown in Figure B3.5. Click Ok. 

NeuralWorks Professional II/PLUS 

File InstaNet I/O Instrument Run Utilities UDND Help 

Figure B3.4 - Sample Screen Plot 

Figure B3.5 - Sample Screen Plot 

Note: Based on experience, a larger number will train the network more closely. 

2. The network will complete the training in seconds. Then select >Run>Test from the 
Run pull down menu. A new window will appear (see Figure B3.6). Click OK. 
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Run / Test 

For f l " 

P One Pass/All 

r One 

C Jraining File Pass 

OK Cancel Help 

Figure B3.6 - Sample Screen Plot 

3. After the testing a file trainJxt.nnr will be created in the folder where the train.txt 
(the testing file) is located. Open that file using the Notepad application or other text 
editor. 

BL train_txt.nnr - Notepad 

File Edit Format Help 

0.000000 
1.000000 
0.000000 

0.000000 
0.000000 
1.000000 

1.000000 
0.000000 
0.000000 

Figure B3.7 - Sample Screen plot 

Figure B3.7 shows the training output. Note that the value of the first row in the output 
file consists of the first categorical number for the number in the first row of the training 
file (1 and 1). This categorical numbering will be the same for all future test files. 

It is always a good idea to train and test the network using the same set of data so the user 
will have an idea which categorical number corresponds to which input. Most 
importantly, for each different category, there must be an equal number of input data used 
when training the network. 
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Application of SOM 

In this section, the user will be familiarized on how the SOM may be applied to a real-world 
situation. A SOM will be created to categorize a set of acoustic emission data that is collected 
from cycling aluminum test specimens. The data will be sorted into rubbing, plastic 
deformation, and fatigue cracking signals. 

The following steps will be used to run the SOM. 
1. First, create a training file which contains the following information. Do not include 

the header section. Save it as SOM train.txt. 

Rise Time 

41 
6 

118 
324 
212 

323 
120 
382 

228 
42 

126 
221 

16 

8 
380 
61 

56 

37 
1 

161 

99 
115 

6 

85 

Counts 

223 
202 

210 
300 
256 

171 
186 
234 
1341 

799 
909 
624 

949 
811 
804 

643 
12 

16 
1 

1 

1 
3 

1 
10 

Energy 

44 

89 
94 

176 
168 

76 
82 

127 
97 
37 
43 
30 
47 
41 

39 

33 
0 

0 
0 
0 

0 
0 

0 

0 

Duration 

1751 

2918 

2284 

2886 

2778 

2175 

2147 

2996 

20727 

12651 

16026 

11446 

17037 

13497 

14795 

13144 

390 

191 
1 
162 

100 
116 

7 
518 

Amplitude 

72 

75 
71 
77 
80 

73 
70 
75 
71 
47 
44 
43 

50 
55 
45 

45 
37 

39 
30 

31 
30 
34 

32 

36 

Counts to Peak 

13 
1 
22 
32 
23 
23 
20 
37 
27 
3 

8 
10 
1 
1 

9 
7 
5 
4 
1 

1 

1 
2 

1 
6 

"N 

> Plane Strain 
Fracture 

J 

> 
Mixed 
Mode 
Fracture 

> 
Plastic 
deformation 

Then create a SOM using the same settings as shown in Figure B3.8 and then proceed 
to train the network. 
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InstaNet / Self Organizing Map x| 

Inputs 

ttRows 

ttCols 

Hidden 

Output 

6 

1 

3 

LCoef 

0.060 

0.250 

0.150 

8S0M steps 

Beta 

Gamma 

LCoef Ratio 

Trans. Pt. 

2000 

0.042 

1.000 

0.500 

10000 

Mapping Layers 

Learn Rule 

ExtDBD 
QuickProp 
MaxProp 
Delta-Bar-Delta 

Sigmoid 
DNNA 
Sine 

Coord. Layer 

Output Network 

I * MinMax Table 

l~~ Interpolate 

Neighborhood: 

Diamond 

Square 

Alternating 

F Start Width 

End Width 

Wrap Around: 

T Horiz. r Vert. 

I * Connect Prior 

W Connect Bias 

l~" Linear Output 

r SoftMax Output 

I/O Files 

Learn Browse.. 

|SOM_train.txt 

Recall / Test 

|SOM_train.txt 

Browse.. 

Epoch 

Figure B3.8 - Sample Screen Plot 

3. After the initial training, the same training file will be used to test the network to 
determine the categorical numbers that are assigned by the network. 

^SOM_t 

File Edit 

Li 

rain_txt.nnr - Notepad 

Format Help 

0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 

0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 

-In 

1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 

• 

*l 

J 

1 
J 

Figure B3.9 - Sample Text File 
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The output file shows the categories for the plane strain fracture are (0 0 1), mixed 
mode fracture are (0 1 0) and the plastic deformation signals are (1 0 0). 
Now, a test file may be used on the trained network to show the network is capable of 
categorizing the data into three predefined categories based on the training file 
created. 
The test file will contain the following information: 

228 
41 
6 
118 
324 
228 
42 
126 
221 
59 
56 
37 
1 
161 

1341 
223 
202 
210 
300 
1341 
799 
909 
624 
29 
12 
16 
1 
1 

97 
44 
89 
94 
176 
97 
37 
43 
30 
1 
0 
0 
0 
0 

20727 
1751 
2918 
2284 
2886 
20727 
12651 
16026 
11446 
502 
390 
191 
1 
162 

71 
72 
75 
71 
77 
71 
47 
44 
43 
41 
37 
39 
30 
31 

27 
13 
1 
22 
32 
27 
3 
8 
10 
3 
5 
4 
1 
1 

After the testing, the output of the testing file should like this: 

1 % SOM J 
File 

U 

Edit 

:est_txt.nnr - Notepad 

Format Help 

0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
1.000000 
1.000000 
1.000000 
1.000000 
1.000000 

1.000000 
0.000000 
0.000000 
0.000000 
0.000000 
1.000000 
1.000000 
1.000000 
1.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 

_|n|x| 

0.000000 
1.000000 
1.000000 
1.000000 
1.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 
0.000000 

^m 
Figure B3.10 

The first data is considered as mixed mode fracture, the second through fifth data are 
consider as plane S Introduction to Kohonen Self-Organizing Neural Network by Hand strain 
fracture and so on. 
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Conclusions 

• A SOM is a powerful technique that can be used to categorize data that does not have 
an obvious pattern. 

• The network must be tested with the same training data set to determine the 
categorization scheme used by the network. 

• The training data needs to have the same amount of data for each category. 
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Appendix C 

Example of Back Propagation Neural Network by Hand Calculation 

Objective 

Determine new weights for back propagation network with two inputs (XI, X2), two middle 
layer processing elements (PEs) (Yl, Y2), and a single output (Zl). Use a learning 
coefficient (LC) of .25 and a sigmoid activation function. 

Network Schematic 

Figure Cl - Network Schematic 

Initial Data 

W i - 0.7 
-0.2 

-0.4 
0.3 

|0.4 
|0.6 

Vk=|0.5 0.1 | -0.3| 

Process 

First compute middle layer output: 

y j =EWij*Xi 
Y(out) = f(yj)=l/(l+e-w) 

Next compute the output and associated error: 

Z , = V „ Y , + V , 2 Y 2 + V,B 
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8k = 5Z, = (Tk - Zk)f (ZO = (T, - Zi) * f(Zl) * (l-f(Zl)) 

Update middle to output layer weights: 

AWjk = L C * 6 k * Y J 

Compute middle layer error: 

8, = 8k*V j k*f(Yj) 

Update input to middle layer weights: 

AWy = LC * 5, * Xj 

Repeat process iteratively until required error value is reached (reference hand calculations). 

Summary of Results 

Table 1 lists the iterative weight values for the given initial data set. Iterations were stopped 
upon reaching 10% error. 

Iteration: 
Wij: 

Vk: 
Iteration: 

WIJ: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 

Table C I -

0 
07 
-0 2 
05 
1 

07 
-0 2 

0 517 
2 

07 
-0 2 

0 531 
3 

07 
-0 2 

0 546 
4 

07 
-0 2 

0 561 
5 

07 
-0 2 

0 576 

-0 4 
03 
01 

-0 3962 
0 3006 
0 121 

-0 3924 
0 3014 
0 142 

-0 3889 
0 3022 
0 162 

-0 3851 
0 3031 
0 182 

-0 3813 
0 3041 
0 202 

04 
06 
-0 3 

0 4038 
0 6006 
-0 27 

0 4076 
0 6014 
-0 24 

04111 
0 6022 
-0 212 

0 4149 
0 6031 
-0184 

0 4187 
0 6041 
-0156 

Iteration: 
Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 
Iteration: 

Wij: 

Vk: 

10 
07 
-0 2 

0 646 
25 
07 
-0 2 

0 791 
50 
07 
-0 2 

0 929 
75 
07 
-0 2 

1013 
100 
07 
-0 2 

1072 
133 
07 
-0 2 

1 128 

-0 3632 
0 3100 
0 288 

-0 3182 
0 3293 
0 472 

-0 2677 
0 3559 
0 648 

-0 2342 
0 3752 
0 753 

-0 2094 
0 3900 
0 826 

(solved) 
-0 1845 
0 4052 
0 897 

0 4368 
0 6100 
-0 036 

0 4818 
0 6293 
0 220 

0 5323 
0 6559 
0 461 

0 5658 
0 6752 
0 604 

0 5906 
0 6900 
0 702 

0 6155 
0 7052 
0 797 

Summarv of Iterative Solutions (1st Data Set) 

Table C2 lists the iterative weight values for a second data set: Xi = 3.0, X2 = 4.0 & Zi = 1.0. 
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Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 

Table C2 

0 
0 7 
-0 2 
0 5 
1 

0 7055 
-0 1981 
0 524 

2 
0 7109 
-0 1959 
0 547 

3 
0 7163 
-0 1936 
0 569 

4 
0 7215 
-0 191 
0 590 

5 
0 7265 
-0 1884 
0 610 

-0 4 
0 3 
0 1 

-0 3927 
0 3026 
0 1181 

-0 3854 
0 3055 
0 1357 

-0 3783 
0 3086 
0 1528 

-0 3714 
0 3119 
0 1693 

-0 3646 
0 3154 
0 1852 

0 4 
0 6 
-0 3 

0 4018 
0 6006 
-0 272 

0 4036 
0 6014 
-0 245 

0 4054 
0 6021 
-0 219 

0 4072 
0 603 
-0 194 

0 4088 
0 6039 
-0 171 

Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 
Iteration: 
Wij: 

Vk: 

10 
0 7493 
-0 1746 
0 699 

25 
0 7828 
-0 149 
0 830 

50 
0 8325 
-0 1021 

1035 
75 

0 8527 
-0 0809 

1 126 
94 

0 8631 
-0 0696 

1 175 

-0 3343 
0 3339 
0 257 

-0 2897 
0 3681 
0 366 

-0 2233 
0 4306 
0 548 

-0 1964 
0 4588 
0 632 

(solved) 
-0 1825 
0 4738 
0 677 

0 4164 
0 6085 
-0 068 

0 4276 
0 6170 
0 079 

0 4442 
0 6326 
0 304 

0 4509 
0 6397 
0 402 

0 4544 
0 6435 
0 454 

- Summarv of Iterative Solutions (2nd Data Set) 

Examples of Linear Regression Analysis and Back Propagation Neural Network 
Software 

Linear Regression Analysis (LRA) has been used as a method to help model linear problems. 
Traditionally, it was done by finding the slope (m) of a linear function (y =mx + c) that best 
fits the data. The linear function can then be used to predict the outcome of new data values 
found within the defined limits of the line. An alternative to the above method may be 
performed by training a neural network. A Back Propagation Neural Network (BPNN) is 
developed and then trained with test data values. The network learns the relationship between 
the input and output values by iteratively comparing the error between the predicted and 
actual outcome and then adjusting the system weights. The BPNN will then be able to predict 
the outcome of the new data. The structure of the BPNN used for LRA is the following: 

Linear Transfer Function 

Y = p0 + p1X1 

Figure Cl.l 
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This tutorial consists of step-by-step documentation supplemented by screen shots for the 
software tool utilized and the selected options demonstrated. The conclusion contains a 
comparison of the results between using LRA from Microsoft (MS) Excel and a BPNN on 
the data and recommendations for better training of the BPNN. 

Objective of tutorial 

The objectives of this tutorial are to: 
• Demonstrate the effectiveness of the BBPN in achieving the same goal of using LRA. 
• To familiarize the user with the software tools. 

o MS Excel 
o NeuralWorks Professional II/PLUS (NWP2+) 

• To develop specific performance skills. 
o Ability to perform LRA using Excel 
o Construct a BBPN using NWP2+ 
o Train the constructed BBPN 
o Supply the BBPN with test data 

Collected Data 

Table CI.2.1 contains a set of data that was collected, and then plotted in Figure CI.2.2 using 
Excel (Steps of data plotting are not discussed in this tutorial). 

60 



X 
27.20 
27.25 
28.38 
30.29 
33.10 
34.18 
35.07 
38.93 
43.65 
45.35 
45.38 
48.56 
56.93 
57.79 
58.01 
58.07 
61.17 
70.09 
79.13 
79.21 
70.34 
71.03 
74.64 
74.72 
77.43 

Y 
11.88 
11.02 
12.13 
11.23 
12.54 
10.31 
10.98 
9.82 
8.87 
8.24 
11.60 
9.35 
9.72 
8.81 
8.63 
10.22 
9.49 
6.68 
7.99 
7.95 
8.38 
7.91 
8.78 
6.21 
8.44 

Table CI.2.1 - Sample Data Set 
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Figure C1.2.2 - Scatter Plot of Sample Data 

As Figure CI.2.2 illustrates, the data demonstrates linear properties. It is therefore feasible to 
model this data with a linear equation. The next step is to find the straight line that best fits 
the data. That procedure is demonstrated using MS Excel and NWP2+ with BBPN. 
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Linear Regression Analysis with Excel 

In this section, MS Excel is used as a tool to help find a best-fit straight line to fit the data in 
Table Cl.2.1. The data should be formatted as previously shown into two-separated columns. 

Excel Configuration 

Prior to beginning the analysis, MS Excel must be properly configured. First determine 
whether MS Excel's Analysis Toolpak has been installed by clicking on the >Tools pull 
down menu (see Figure C 2.1.1). If the >Tools>Data Analysis... option exists, then the 
remainder of this section should be skipped. 

0 Microsoft Excel - atra1.nna.prn 

8 ] File Edit View insert Format Tools Data Window Help 

o G* y d> # a v \ J 
C10 - • 

1 
2 
3 
4 
5 
6 
7 

8 
9 
10 

A B C 
27.2 11.88 

27.25 11.02 
28.38 12.13 
30.29 11.23 

33.1 12.54 
34.18 10.31 
35.07 10.98 
38.93 9.82 
43.65 8.87 

v^ Spelling... F7 

Share Workbook... 

Protection • 

Online Collaboration • 

Customize... 

Options... 

Data Analysis... 

* 

\ A f i U 5 

F I 

45.35 8.241 1 

Figure C 2.1.1 - >Tools>Data Analysis... Screen Capture 

If the >Tools>Data Analysis... option is not available, follow the next steps to install the 
Data Analysis Toolpak: 

1. Select >Tools>Add-Ins... item under the >Tools pull down menu. The following 
window will be displayed: 
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Add-lns 

Add-lns available: 

I"" Access Links 

P Analysis ToolPak - VBA 
I " Autosave Add-in 
I™ Conditional Sum Wizard 
r" Euro Currency Tools 
["" Internet Assistant VBA 
P Lookup Wizard 
["" MS Query Add-in 
r ODBC Add-in d 

HD 

OK 

Cancel 

Browse... 

Analysis ToolPak 

Provides functions and interfaces for financial and scientific 
data analysis 

Figure C 2.1.2 - Add-lns Window Screen Capture 

2. Click the box next to 'Analysis ToolPak' to add a check and then click the OK 
button. The window will disappear and MS Excel will install the Analysis 
Toolpak package. 

You may now wish to return to the >Tools pull down menu to confirm that the >Tools>Data 
Analysis... option is now available. 

Data Analysis - LRA 
Prior to this point, the data in Table CI.2.1 should have been formatted into two separate 
columns. 

The following steps describe how to perform LRA using Excel: 

1. Select >Tools>Data Analysis... under the Tools pull down menu which will 
bring up the following window: 

Figure C 2.2.1 - Data Analysis Window Screen Capture 
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Scroll down the list and select 'Regression' as shown in Figure C2.2.1. Click the 
OK button and then Regression window will appear: 

Regression 

Input 

Input Y Range: 

Input X Range: 

r Labels 

f" Confidence Level 

|$B$1:$B$25 

|$A$1:$A$25 

\ Constant is Zero 

95 

Output options 

f Output Range: 

fr New Worksheet Ply: 

C New Workbook 

Residuals 

I - Residuals 

l"~ Standardized Residuals 

lormal Probability 
r Normal Probability Plots 
Norm* 

M 

Click this button to 
manually select the 
Input Y Data range. In 
this instance, Column B 
from Row 1 to 25 
contains the data to be 
analyzed. Follow the 
same procedure to 
select the Input X Data 
range. 

Select this option to 
automatically plot a graph 
displaying the 
data and the best-fit line. 

Figure C2.2.2 - Regression Window Screen Capture 

3. Select the input range for X and Y as shown in Figure C2.2.2 and select the 
Residuals option for Line Fit Plots. Click on OK. 

4. A new worksheet will then be generated: 

Values of (30 and P, 
of the best-fit line 
function. In this 
case, the value of 
Po is (-0.07618) 
and value of P] is 
(13.52757). 

;UMMARY OUTPUT 

3 Regie. n Statistics 
Multiple R 0 827443 

I R Square 0 684663 
Adjusted f- 0 670952 
Standard E 0 969668 
Observatio 25 

F <grnl>cance F 
46 98982 45 98982 49 93777 3 36E-07 

21 18168 0 920943 

67 1715 

X Variable 1 Line Fit Plot 

15 j 

10 -

5 

0 

H , 
* * > * 

50 

X Variable 1 

lard Err I Stat Pvalue Lower 95%Upper 95% omr 95 Pepper 95 0% 
603105 22 42986 3 92E17 12 27995 14 77516 12 27995 14 77518 

0 01078 -7 06667 3 36E-07 -0 09848 -0 0S388 -0 09848 -0 05388 

22 RESIDUAL OUTPUT 

24 j b * oPredKted V Residuals 
1 11 45543 
2 11 45162 
3 11 36553 
4 11 22003 
5 11 0D596 
6 10 92368 
7 10B5588 
8 10 56182 
9 10 20224 
0 10 07273 
1 10 07045 

14 4 • M \ S h e e t l / 

28 
29 

hoj 

0 424573 
-0 43162 

0 764467 
0 009974 
1 534044 
-061368 

0 124122 
-0 74182 
1 33224 

-183273 
1 529654 / 

Graph with the Y and the predicted Y using the 
line function that is found by LRA. 

hi i»ir 

Figure C2.2.3 - Regression Worksheet Screen Capture 
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The equation for the best-fit straight line can then be determined to be: 

Y = -0.07618 +13.52757X! 

Linear Regression Analysis Using NeuralWorks Professional II/Plus 

The approach of performing LRA using the BPNN is very different than using MS Excel. It 
does not actually find the slope of the line that best-fits all of the collected data. It trains the 
network with the collected data so the network will be able to predict the outcome of new 
sets of collected data. 

Network Preparation 

In order to use the Neural Network, two separate files are prepared. One file consists of the 
training data, which is used to train the network. The other consists of the test data used to 
test the network. 

Steps for creating 2 separate files: 

1. Start Notepad (or other test file editor) and enter the collected data in two columns as 
shown: 

Figure C3.1.1 — Text Editor Screen Capture 

2. Then, select >File>Save As... from the File pull down menu. The Save As window 
will be displayed: 
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Select the'Save 
as type:' to 'All 
Files' before 
saving. 

Type in the 
filename with a 
'.nna' file 
extension. This is 
the only file type 
NWP2+ can work 
with. 

Figure C3.1.2 - Save As Window Screen Capture 

3. Now, save the file ates-al.nna and ates.nna in the same folder. (Any folder is 
acceptable so long as it may be located later.) 

Two files are then created: ates.nna used for training the network and ates-al.nna used to test 
the network. 

Back Propagation Neural Network Construction 

Before you construct the Neural Network, a defined structure of the Neural Network needs to 
be defined and decided upon. In this case, the structure of the network will be the same as in 
Figure 1.1. The reason for using this structure is that we know the collected data has the 
linear properties and the output of this neural network will give a linear equation. 

The steps to construct the BPNN for the collected data are the following: 

1. Startup NWP2+ and select >InstaNet>Back Propagation. 
down menu (see Figure C 3.2.1). 

from the InstaNet pull 
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NeuralWorks Professional II /PLUS 

File 

\ 

InstaNet I/O Instrument Run Utilities UDND Help 

Adaptive Resonance Theory... 

General Regression Neural Network 

Learning Vector Quantization... 

Modular Neural Network... 

Probabilistic Neural Network... 

Radial Basis Function Network... 

Reinforcement Networks... 

Self Organizing Map... 

2. 

File for 
training 
network 

File for 
testing the 
network 

Figure C 3.2.1 - Creating BPNN 

After selecting Back Propagation..., a new window will pop up as shown in Figure 
C 3.2.2. This window defines the structure of the network. Set the variables 
accordingly using the values in Figure C 3.2.2. 

InstaNet / Back Propagation 

Learn Rule 

Ext DBD 
QuickProp 
MaxProp 
Delta-Bar-Delta 

Transfer 

TanH 
Sigmoid 
DNNA 
Sine 

This button 
allow user to 
locate the two 
files that is 
created before. 

Figure C3.2.2 
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3. After entering all of the values, click OK, and a new window will popup as shown in 
Figure C3.2.3. This window allows the user to select what results will be displayed 
after the training. In this case, select RMS Error and Network Weights, and then 
select OK. 

Figure C3.2.3 

Back Propagation Neural Network Training 
With the network now constructed, you are seconds away to train the network. 

The steps to train the network are as follows: 

1. Select the >Run> Learn... from the Run pull down menu as shown in Figure 
C3.3.1. A new window will appear like the one in Figure C3.3.2. 
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NeuraFWorks Professional II /PLUS 

File 

v 

• 
BttJ 

InstaNet I/O Instrument 

1 

0 

RMS Error 0.0000 

Run Utilities UDND Help 

Test... Ctrl+T 

Save Best... Ctrl+U 

Initialize Network Ctrl+I 

Recall... Ctrl+R 

Recall Start 

Recall Step 

FlashCode... 

Explain... 

Checkpoints... 

k Weights 10 

Figure C3.3.1 

Run / Learn 

P For |4000| 

One Pass/All 

One 

C Now 

r Until 

OK Cancel Help ! 

Figure C3.3.2 

2. Enter 4000 in the field box as shown in Figure C 3.3.2. Then, click OK to start the 
training. 

While the network is training, the screen may flicker a bit, especially on the top left hand side 
of the screen. It will display a wave signal line moving. Wait until the wave signal stops, 
signifying the end of training. After the training, the screen should look similar to Figure C 
3.3.3. 
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NeuralWorks Professional II/PLUS 

File InstaNet I/O Instrument Run Utilities UDND Help 

Untitled 

nvu^ n 

-10 Network Weights 

y i • u 'j 

RMS Error 0.1910 

Figure C 3.3.3 

The value of the RMS Error in the graph displays the average difference of the expected 
value (from the collected data) and the computed value from the network. The smaller the 
number, the closer the network is trained. 

Back Propagation Neural Network Testing 

With the trained BPNN ready, the same set of data can be used to test the network again. 

The steps to test the neural network are as follows: 

1. Select >Run>Test from the Run pull down menu (see Figure C3.3.1). A new 
window will appear as shown in Figure C3.3.2. This time select One Pass/All instead 
of For. 

2. Click OK, and the network will begin testing. Wait until the signal wave stops 
moving indicating the testing is complete. After the testing, the screen should look 
similar to Figure C3.4.1. 

71 



NeuralWorks Professional II/PLUS 

File InstaNet I/O Instrument Run Utilities UDND Help 

Figure C3.4.1 

After the execution of the testing on the network, an output result file will be created. In this 
case, ates-al.nna is used for the testing, so the output file will be atra-al nna.nnr. Open 
atra-al nna.nn using the Notepad application or other text editor. It will look like the one 
shown in Figure C3.4.2. 

B± ates-a1_nna.nnr - Notepad 

File Edit Format Help 
BED 

This column has the 
collected value 
(expected value). 

L 

11.880000 
11.020000 
12.130000 
11.230000 
12.540000 
10.310000 
10.980000 
9.820000 
8.870000 
8.240000 
11.600000 
9.350000 
9.720000 
8.810000 
8.630000 
10.220000 
9.490000 
6.680000 

11.601887 
11.598212 
11.515159 
11.374777 
11.168246 
11.088867 
11.0234 54 
10.739750 
10.392837 
10.267890 
10.265684 
10.031960 
9.416778 
9.353568 
9.337399 
9.332989 
9.105144 
8.449537 

This column has 
the computed value 
on the trained 
network. 

Figure C3.4.2 
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Conclusions 

• Back Propagation Neural Networks can accurately simulate Linear Regression 
Analysis as performed by MS Excel. 

• However, the degree of accuracy and effectiveness of using BPNN to achieve this 
goal depends on the quality of the training. It was shown in the tutorial that results 
varied with training parameters. 

• Since BPNN is highly dependent on training, the training process may be augmented 
by using random input training sequences and lowering the transition point. 
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